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Les tableaux dans Pages.

Un tableau, pour quoi faire?

Entrer des données et éventuellement les trier.
Vous pouvez créer un tableau depuis:
e L'outil tableau.

e Le menu insertion > tableau.
e Un tableau créé avec Word.

Ajoutez I'outil tableau a la barre d’outils.

Partager Fenétre Aide
Inspecteur >
Afficher les vignettes de page P
Afficher le nombre de mots .
Afficher la régle #R
Guides >
Afficher la mise en page oL
Afficher les caractéres invisibles {881
Commentaires et modifications >
Afficher les outils de disposition
Afficher les couleurs 0 38C
Afficher Ajuster I'image
Agrandir/réduire >
Afficher les avertissements
Activer le mode plein écran ~8F
Masquer la barre d'outils BT
Personnaliser la harre d'outils...

Si vous créez souvent des tableaux dans Pages, ajoutez
I'outil tableau dans la barre d’outils.

Pour personnaliser la barre d’outils allez dans le menu
Présentation > personnaliser la barre d’outils >
faites glisser I'outil tableau dans la barre d’outils.

@ Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
\ [ ] 7 rampe85.pages
&S  125%v O-BAcl A-BA-RORT-A T 7| = h-§ @ a |
Imprimer  Zoom Tableau ntation Polices Plus grand Plus petit Couleurs Insérer Texte Donné imédias C: Partager Indices Recherche  F¢
Pages B
Faites glisser vos élé favoris dans la barre d’outils...
B~ v q~ al T H = = v a2 5]
Présentation Zoom Insérer Table35 Graphique Texte Figure Données multimédias Commentaire Partager Indices Format Document
" - L 0 2 A+ A- A' A .

= =

Q

Ajuster I'image Recherche Imprimer

A =

1" .
er

... ou faites gli:

Désindenter Indenter Suivi des modifications Guides Copier le style Coller le style Masquer Alpha instantané Verrouiller Déverrouiller Polices

par

Plan supérieur Plan inférieur Devant Derriére Retournement horizontal Retournement vertical Grouper Dissocier Plus grand Plus petit Exposant Indice

= & ¢ g 8 % Aa

@

Lien

2€]
o lmgy=
Couleurs Espace Espace ajustable

Adfant

sur la barre d'outils.

B e R

Présentation Zoom

Afficher

Icone et texte

Insérer Tableau Graphique Texte

EN ©

Format Document

T

L[]

- a hv @

Figure Données multimédias Commentaire

Partager Indices

L —
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W Prages richier tdiuon Inseruon rormat Uisposition Fresentation Partager renetre Aide

e 00 Sans titre — Modifie

Tableau

? ‘*

Pour créer un tableau, positionnez-vous dans votre page, cliquez sur I'outil tableau et
choisissez un modéle de tableau.

W8 Pages Fichier taiton Insertion Format Uisposition Presentation rartager Frenetre Aide
e 00 Sans titre — Modifié

1 — e ————————

! rgej ricnier  caiion  INseruon  rormat  UISposiLion  Fresentaluon rariager renewe Aide
806 Sans titre — Modifié =

S [msx]

Tableau

©

Styles de tableau
.

En-tétes et bas de tableau
(B 13 (B 13 (= 03]
[ Nom du tableau

"I':Il’lll:a:e Ia police du
? -

Pages inséere un tableau selon le modele que vous avez choisi.
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Créer un tableau depuis le menu insertion.

® Pages richier tdiion guiogoge rormat  Disposition  rresentation  rartager renetre  Aide
Section Sans titre — Modifié

Saut de section
Saut de page ¥R
Saut de colonne

Numéro de page
Nombre de pages
Date et heure

Tableau

Table des matiéres >
Note de bas de page

Tableau > Sous-sectionsy
Graphique > Standard -
Zone de texte Standard

Figure > Sommes

Ligne > )

Surligner £ 8H

Commenter 3K

e Tl

@ Fages ricnier EQILON  INSerUON  rOrmal  UISpOSILOn  Fresentalion rartager renetre  Aide
e 06 Sans titre — Modifié "
-

&)

i S p—

Styles de tableau
.o

En-tétes et bas de tableau
(BB 13 (A 13 (@ o)

(] Nom du tableau

Vous pouvez aussi créer un tableau depuis le menu insertion > tableau > sous-sections ou
autres modéles situés dessous.
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Créer un tableau tout simple.

@ Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide

[ NON ) “ rampe85.pages — Modifié
= 125%v == b~ Aa A+ A- O RYTYR T Lal M~
Imprimer  Zoom Tar “au Présentation Polices Plus grand Plus petit Couleurs Insérer Texte Données multimédias Commentaire Partager
f ... ou faites glisser Mensembie par Gétaut sur la barre d'outis.
}----F - T & o = o+ EN®
.:: | Présertaton  Zoom sdver Tableos Graghigue Teste  Figuew  Donndes mutimécias Commentare  Partager Indices  Format  Document
0. | ‘ 3 | | 3
u N Y N /™ AP T - [“orminé |
1 p— —
| s i ]
.ancement 85 Pages pour OS X Page 6
N [ |
L | 1 ]
L]
S
h O A B C D I
2
5
f"'| 2
s 3 s
- 4
3 5
o o
T — I

Parmi les modéles il y a un modeéle de tableau tout simple de 4 colonnes X 5 lignes.
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Ouvrir un tableau depuis un document Microsoft Word.

® Pages JiGiCg tdition

Insertion Format

® 00

&N

Nouveau...

EEE ———
0.0.0 Ouvrir
[« » [z |Bl @ m |[ = - | & Macintosh HD ™
(L] Dropbox Nom -
E\, Tous mes fichiers [S E rami:>e70
# Calculette.app » [ rampe71
/\ Applicati » [ rampe72
B pplications > [l rampe73
[ Bureau v (] rampe74
Images B_fichier-indexation-excel.docx

2} yvescornil

Y rampe74.docx

rampe74.jpg

T — R
@ Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
I | est poss | b I e (- NaNs) fichier-indexation-excel )
’ H = [125% -] - [l =]

d’ouvrir un doc- e e T p.E,. e
ument Word qui
contient un I
tableau.

. , .doc Document Word
I ¢ c es t un .doex Document Word
ta b/ ea u a ss ez .exe Programme exécutable
importan t, qui pdf DOCumelfﬂ PDF
évitera la saisie . -
d’un tableau de v S——
pIUSieUI’S pages Xls Document Excel
/Ors des exercices Xlsx Document Excel
pra tiques réa/iSéS f‘;’tivation :::::Ton
lors de l,a teller administrateur Administrateur ” i
P a g es d u CI / ac. adresse Adresse Sélectionnez l'objet ou le texte 2

mettre en forme.
adresse ¢lectronique Adresse ¢lectronique
ajuster la taille des cellules Ajuster la taille des cellules
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Insérer une ligne au-dessus.

o) ( A | B 1]
: T
H -doc Répéter les rangs d’en-téte sur chaque page
2 -
.docx Irsérer un rang au-dessus
3| |.exe Insérer un rang en dessous
4 | pdf Insérer une colonne avant
. Insérer une colonne aprés
pps
6| | posx Supprimer le rang
Supprimer la colonne -
R — R
®)| A B Il
| I
] J
2 | .doc Document Word
3 | .docx Document Word
T — L e

Pour insérer une ligne, positionnez-vous dans une cellule, un clic droit > insérer un rang
au-dessus.

W rages ricnier caiion Inseruon rormat  vIsposilion  rFresentation rartager renetre  Alae

e 00 fichier-indexation-excel — Modifié e
= EH O Aa A+ a- O T | E u @ Qs
Tableau Cellule Texte Disposition
o) A | B I - I i |
I 1 ‘ ‘ mot a indexer Hlndex
= -
2| | .doc Document Word = ! -
3 | .docx Document Word [ 1 ] =
4| | .exe Programme exécutable Styles de tableau
L
5 | .pdf Document PDF
6| | pps PowerPoint En-tétes et bas de tableau
: (BB 0% [E 1% (E 0%
7| .ppsx PowerPoint g
. [} Nom du tableau L3
8 | .ppt PowerPoint
9 Taille de la police du
xls Document Excel paas | ——
10 | xIsx Document Excel
L —— R

Vous pouvez aussi insérer un rang en dessous ou une colonne, a droite (apres) ou a
gauche (avant).
Vous pouvez aussi supprimer une ligne (rang) ou une colonne depuis le clic droit.
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Dans le vocabulaire de Pages une ligne s’appelle un rang.

Saisie dans une cellule.

) A B Il
O
1| | mot a indexer A
o
2 | .doc Document Word
3 | | .docx Document Word
L — e

Pour saisir une donnée positionnez le curseur dans la souris dans une cellule et saisissez
vos informations.

Définir une ligne de titre.

¥ rages ricnier caiuon Inseruon rormat visposition rresentation rartager renetre Aige

e 006 fichier-indexation-excel — Modifié >
(T 125 % - EH O Aa A+ a- O T Ln E u @ Qs
Imprimer Zoom Tableau Présentation Polices Plus grand Plus petit Couleurs Insérer Texte Données multimédias Commentaire Partager Indices Recherche
Cellule Texte Disposition
e
() A B 1}
1 || mot a indexer uindex
)
2 | .doc Document Word
3 | | .docx Document Word
4| | exe Programme exécutable 5
5 | .pdf Document PDF
- En-tétes et bas de tableau
6 | .pps PowerPoint — —
|EB o35 |(voO |E 0%
7 | .ppsx PowerPoint 5 N
[ JNomdutab 5
8 | ppt PowerPoint 3
Tailledelapa 4 A PRTSTR
9
Xls Document Excel ehleas . (alA]
10/ | xlsx Document Excel
L — T

Pour définir une ligne de titre, positionnez-vous dans une cellule de la premiére ligne et
cliquez sur I'outil en-téte et bas de tableau et dans le menu déroulant choisissez le nombre
de lignes a prendre en compte.

Dans le vocabulaire de Pages la ligne de titre s’appelle rang d’en-téte.
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Répéter le rang d'en-téte sur chaque page.

W rages

ricnier

caiuon Inseruon  rormat  vispositon

rresentaton rartager

renetre Aide

e 00

fichier-indexation-excel — Modifié

Texte

Ol A \ 8 ) E:L;LL; l 1]
~/ —/ I I
T 1 B I
U | mot A Indexer Rép\ter les rangs d'en-téte sur chaque page
2 | .doc . . - = |
Insérer un rang d’en-téte au-dessus ] || R
3| .docx Insérer un rang d’en-téte en dessous o o | 1 —
4| |.exe Insérer une colonne avant Styles ".".‘“b'““
s || .par Insérer une colonne apreés
6| |.pps Supprimer le rang En-tétes et bas de tableau
= Supprimer la colonne [Em o4 (A 14 ([ED 03]
~—— ———
23 | ascenseur Ascenseur
24 | attributs d’un texte Attributs d’un texte ,
25| | barre de menus Barre de menus
26 | barre de taches Barre de taches
27| | barre latérale Barre latérale
28 | barres d’outils Barre d’outils
29 | bas de page Pied de page
30 | boite d’envoi Boite d’envoi
( A | B
m mot a indexer index
-
31 | boite de réception Boite de réception
32 | Boot Camp Boot Camp
33 | BootCamp Boot Camp
34 | bordure Bordure

Si vous avez de longues listes, répétez la ligne d’en-téte.
Cliquez sur la premiére ligne, un clic droit > répéter les rangs d’en-tétes sur chaque page.

Rampe de Lancement 117
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Trier une colonne.

® Pages richier tdition Insertion Format DiISposition Presentation Partager trenetre A
e O 0 fichier-indexation-excel — Modifié
= I3l
[ 125 % ~ EH O Aa A+ a- O T LR =
Imprimer Zoom Tableau Présentation Polices Plus grand Plus petit Couleurs Insérer Texte Données multimédias Comme
® Trier en ordre crgissant I
| P Trier en ordre décroissant
2| | .doc Insérer une colonne d'en-téte avant
Convertir en colonne d'en-téte
3 2
-docx Insérer une colonne avant
4l |axs Insérer une colonne aprés
5 | .pdf Supprimer la colonne
6 | .pps Aiuster la largeur au contenu
L — e

Dans Pages vous pouvez trier une colonne en ordre croissant ou en ordre décroissant.
Cliquez sur le colonne, tout en haut, un clic droit > trier en ordre croissant ou en ordre

décroissant.

Le vocabulaire de Pages.

®Une ligne = un rang.

®Ligne de titre = rang d’entéte.
® Avant = a gauche.

®Aprés = a droite.

Ajouter des lignes en fin de tableau.

34 | WPA WPA
345 | XPS XPS
346 | zip Compression
347 | zoom Zoom
357 N
| — ——

Pour ajouter une ligne en fin de tableau, cliquez sur le petit rond situé en bas a gauche du
tableau pour faire apparaitre un compteur; cliquez sur le triangle du bas pour ajouter des
lignes, sur le triangle du haut pour diminuer le nombre de lignes (rangs).

Rampe de Lancement 117 Pages 6.1 pour macOS
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347 | zoom Zoom

=

( A | 8

m mot a indexer index

350 i

351

352

353

354

385

356

3s7

358

359

360

®

?7 *
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Ajouter une colonne dans un tableau.

® A B 2 iﬂ
1 | | mot a indexer index
2 | .doc Document Word
3 | | .docx Document Word
4| |.exe Programme exécutable
10— EE—

Pour ajouter une colonne a droite, cliquez dans le petit rond, en haut a droite puis sur le
petit triangle du bas pour ajouter des colonnes, sur le triangle du haut pour en supprimer.

CY A # [ 3 [k
1 | mot a indexer index
2 | doc Document Word
3 | .docx Document Word
4| |.exe Programme exécutable
5| | .pdf Document PDF
6 nna PawearPaint
L — e
Tableau Cellule Texte Disposition
° A B <1 ==1 | — i
Trier en ordre croissant
1 | mot aindexer index Trier en ordre décroissant -
2| | doc Document Word Insérer une colonne avant
3| | .docx Document Word Insérer une colonne aprés =
4| | .exe Programme exécutable Supprimer la colonne _“‘bm“
5 | .pdf Document PDF Ajuster la largeur au contenu
. ibleau
| |.pps PowerPoint Importer une image sl (@02
= P Capturer la sélection de I'écran =" (=8 0%
ppsx PowerPoint
jom du
8 nnt PowerPaint
L — e

Vous pouvez aussi insérer une colonne a l'intérieur d’un tableau; positionnez-vous dans
une colonne, un clic droit > et choisissez insérer une colonne avant ou une colonne aprés
la colonne ou vous étes positionné.

Rampe de Lancement 117
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Insérer une colonne a droite.

Power
PowerPoint

9) A | o R
~— Trier en ordre croissant

1 | mot aindexer index  Trier en ordre décroissant

2 | doc Docur  Insérer une colonne avant

ol | s Docl Insérer un olonne apres

4| | exe Progri Supprimer la colonne

5| | pdf Docur Ajuster la largeur au contenu
6 | .pps Power Importer une image

Capturer la sélection de 'écran

7 | .ppsx

8 | .ppt

—————

Pour insérer une colonne a droite, positionnez-vous dans une colonne, un clic droit > in-

sérer une colonne apres.

L) A B IO
1 | mot aindexer index
2| | doc Document Word
3 | | .docx Document Word
4| | €xe Programme [N
exécutable
5| | .pdf Document PDF
6 | .pps PowerPoint
7 | .ppsx PowerPoint
T — —————————

Rampe de Lancement 117

Pages 6.1 pour macOS

Page 18



Supprimer une colonne.

Ojmres.. - | c |3 G

1 | mot a indexer index
2| | .doc Document Word
3 | .docx Document Word
4| |.exe Programme exécutable
5| [.pdf Document PDF
6 | .pps PowerPoint
7 | .ppsx PowerPoint
8 | nnt PowerPoint
e e ———
l 5
@C A [N 1 en ordre croissant — 13 0
il e s Trier en ordre décroissant
3| | ase Insérer une colonne avant
Insérer une colonne aprés
3 | .docx
| Supprimex la colonne
4| . exe .
: Ajuster la largeur au contenu
5| | .pdf
= . Importer une image
PP Capturer la sélection de I'écran
0 — e ———

Pour supprimer une colonne, sélectionnez le colonne, un clic droit > supprimer la
colonne.
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Modifier la largeur d'un tableau.

] A B Il
1 | mot a indexer index

2 | .doc Document Word

3 | | .docx Document Word

4| |.exe Programme exécutable

5 | .pdf Document PDF

6 |.pps PowerPoint

Vous pouvez ajuster la largeur d’'une colonne selon vos besoins; positionnez-vous entre 2
colonnes et déplacez 'outil double fléches et déplacer a droite et a gauche.

e

e

i

ol

—
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Pour ajuster la largeur des cellules, amenez avec votre souris sur la limite de séparation
des cellules. La fleche se transforme en double fleche.

Décalez cet outil a droite ou a gauche pour modifier la largeur des cellules.

C’est le méme processus pour modifier la hauteur d’une ligne de cellules.

Ajuster la largeur d'une colonne au contenu.

Luavn HcIuvnl fTulinat widpuUdILIVILE riesciitacivig raiilayci frciecuc Aiuc

| fichier-indexation.pages — Modifié

RS RN Y. TN T YO L U 1 e RO u @

Trier en ordre croissant

1| | mot a indexer inde Trier en ordre décroissant

2 | .doc Doc Insérer des colonnes avant
Insérer des colonnes aprés [

3 | .docx Doc P

4| exe Prog Supprimer les colonnes sélectionnées | |

5| | .pdf o Ajuster la largeur au contenu

6 | .pps Pow Importer une image :I
Capturer la sélection de I'écran

7 | .ppsx Pow

8 || .ppt PowerPoint

T — e —

1 | mot a indexer index
2 | .doc Document Word
3 | | .doex Document Word
4| |l .exe Programme exécutable
5 || .pdf Document PDF b
6 | .pps PowerPoint
7 | .ppsx PowerPoint
—— ———————

Vous pouvez ajuster la largeur des colonnes au contenu.
Sélectionnez le tableau (tout en haut), un clic droit > ajuster la largeur au contenu.
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Répartir uniformément les colonnes.

. IR % z .
~ v Répéter les rangs d'en-téte sur chaque page

Répartir les rangs uniformément

1
Répartir les colonnes unifyrmément

i Placer au premier plan
Placer a I'arriére-plan

¢ Aligner les objets >
 Répartir les objets »
€

- Couper

! Copier

¢ Coller

Tout effacer
¢

Importer une image

| ’ . ”
Capturer la sélection de I'écran

4 T~ Teegu—

T —

———

Vous pouvez répartir la largeur des colonnes uniformément; cliquez dans une cellule, un

clic droit > répartir les colonnes uniformément.

! A B I_l
1 | mot a indexer index
2| | .doc LN Document Word
3 | | .docx Document Word
4| |.exe Programme exécutable
5| |.pdf Document PDF
6| |.pps PowerPoint
7 | .ppsx PowerPoint
8 | .ppt PowerPoint
9 | .xls Document Excel
10 | xlsx Document Excel
5 — EEE—
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Fusionner des cellules.

Pour fusionner les cellules : sélectionnez plusieurs cellules, puis choisissez Format >
Tableau > Fusionner les cellules (dans le menu Format situé en haut de I’écran d’ordi-
nateur).

La fusion de cellules aboutit aux résultats suivants :

Si, avant la fusion, seulement une des cellules contient des données, la
cellule fusionnée finale conserve le contenu et la mise en forme de cette cellule.

Si, avant la fusion, plusieurs cellules contiennent des données, tout le
contenu est conservé, mais les cellules comportant un format de données spécifique,
comme des nombres, des devises ou des dates, sont converties au format texte.

Si une couleur de remplissage est appliquée a la cellule supérieure
gauche, la cellule fusionnée reprend cette couleur de remplissage.

@ Pages Fichier Edition Insertion BJGE Disposition Présentation Partager Fenétre Aide

{®06 Police » |— Modifié &)
-, — Texte > o~
=) [125% - EH O | T Ln u © Qs
Imprimer Zoom Tableau Présentation P Tableau > Insérer un rang au-dessus r Indices Recherche
Craphique 2 Insérer un rang en dessous lle Texte Disposition
Figures et lignes > E— |
Image > Insgrer des colonnes ava[\t
e Vidéo > nsérer des colonnes aprés
[ ] A :
Copier le style X#8C Suppr!mer le rang
1 Collerlactila - a9\ Supprimer les colonnes
2 = Y Rangs d’en-téte >
5 v Répéter les rangs d'en-téte sur chaque page
Colonnes d'en-téte >
4 > Rangs de bas de tableau > .
T
5 Ajuster le rang au contenu Is de tableau
Ajuster la colonne au contenu p—— —
5 (@ o:) (= o¢
Répartir les rangs uniformément k..
Répartir les colonnes uniformément
Remplir automatiquement les cellules p [licedu ——
Fusionner les cellule
Ne plus fusionner »;sk:t ules
ableau
Inverser la direction du tableau SO (02507
| — ———
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Tableau

Ici des cellules au centre du tableau ont été fusionnées.

Dissocier des cellules.

Sélectionnez la cellule, puis choisissez Format > Tableau > Ne plus fusionner les
cellules (le menu Format se trouve en haut de I'écran).

Tout le contenu des cellules qui étaient fusionnées apparait dans la premiere cellule
scindée.

Vous pouvez aussi passer par le menu Format > Tableau > ne plus fusionner les
cellules.

® Pages Fichier Edition Insertion JCIEY Disposition  Présentation  Partager Fenétre  Aide

8006 Police » |— Modifié 7
- | Texte >
= = o ey p— = u o Ol
Imprimer Zoom Tableau Présentation P Tableau > Insérer un rang au-dessus :‘t Indices Recherche
Graphique > Insérer un rang en dessous lle Texte Disposition
Figures et lignes > ; [
Image > Insérer des colonnes avant
e Vidéo > Insérer des colonnes aprés
L) A :
Copier le style X #8C Suppr!mer :e ranlg
1 Coller le style 8V Supprimer les colonnes
7 =
2 Ajouter un lien 38K Rgng’;s d’en-téte : . > e “
z I* sitorimerle lien v Répéter les rangs d'en-téte sur chaque page
Colonnes d'en-téte > B de tableas
4 Avancé > Rangs de bas de tableau > L
T
> Ajuster le rang au contenu E de tableau
Ajuster la colonne au contenu -
= A o+ |[EH 0%
Répartir les rangs uniformément -
Répartir les colonnes uniformément
Remplir automatiquement les cellules p [licedu ——
Fusionner les cellules
Ne plus fusionner les cellules
Ly ableau
Inverser la direction du tableau-] -§| 0,25 pt(3)
L — S
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Une autre possibilité c’est de passer par un clic droit > ne plus fusionner les cellules.

SR T

I

’ = ‘ _ v Répéter les rangs d'en-téte sur chaque page

Insérer un rang au-dessus
Insérer un rang en dessous

Insérer des colonnes avant
Insérer des colonnes aprés

Supprimer le rang
Supprimer les colonnes

Fusionner les cellules

Ne plus fusionner les cellules

Couper
Copier
Coller

Tout effacer

v Ajuster le texte

Importer une image
Capturer la sélection de I'écran

Texte | Disposition

Styles de tableau
.o

En-tétes et bas de tableau

(B8 o3 [E of [E 0%
() Nom du tableau
Taille de la police du |ﬁ\

tableau

Structure du tableau
\, ;) (O o250

] Nom du tableau en relief

Quadrillage
[%‘%][ﬁ‘“ Ln;"

™ Couleur en alternance | (s]

Rampe de Lancement 117

Pages 6.1 pour macOS
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Les outils des tableaux.

- NaNs) 7| execicetableaucilac.pages "

(o e P A O Ll e = L o P O,

Cellule  Texte Disposition

Tableau des activités du CILAC.
oA 8 [ ¢ | o E (i
|v| ‘ T Semaine 20 [ l
13/05  mardi 14h30 4 16h30  Appareil photo numérique 2, utilisation, Josette
2 réglages
Styles de tableau
.o
3 14/05 mercredi | 09h30 a 11h30 | Ininiation Thérése - Luc
4 1405 mercredi | 14h30 4 16h30 Apple - le Pages qui te plait Yves En-tétes et bas de tableau
(B8 o:| (E@ o% [E o3

s 15/05 mercredi | 14h30 a 16h30 Initiation utilisation iPad sous iOS 7 Yves

() Nom du tableau

6 15005 | jeud 17h004 19000 ASSEMBLEE GENERALE DU CILAC - Hevshoplal ko IS ST

Structure du tableau

(—— ¢/ WO o250

(] Nom du tableau en relief

Quadrillage
SE=anEE SN B2 | 68 )

™ Couleur en alternance [s)

¥ Tailles des rangs et colonnes

Rang: 1 0,71 crr@ Adapter
Colonne: 4 1,38 cnr @ | Adapter |

[gAjuster les rangs au contenu des cellules

C — N

Quand vous cliquez dans un tableau un panneau s’affiche a droite.

B Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide ICI depUiS
8006 |# execicetableaucilac.pages — Modifié v I’Onglet
= T A A oy — = u © Q5 cellule on

Tableau ([ peUt don'
Format des données ner un
Tableau des activités du CILAC. format aux
(@) a 8 c D s Ea) (! P
: iy cellules.
1| | Semaine 20 vise
Pourcentage |
13/05 = mardi 14h30 a 16h30 Appareil photo numérique 2, utilisation, Josette Fraction '
2 reglages Systéeme numérique
Scientifique |
3 14/05 | mercredi 09h30 & 11h30 | Ininiation Thérése - Luc o
4 14/05 mercredi  14h30 a 16h30 | Apple - le Pages qui te plait Yves
Date et heure
2 egi T z Durée
5| 15/05 | mercredi | 14h30 & 16h30 | Initiation utilisation iPad sous iOS 7 Yves |
Créer un format personnalisé... I

g
H 15/05 | jeudi 17h00 & 19h00 ASSEMBLEE GENERALE DU CILAC l

(n

Choisissez un style de bordure puis
cliquez sur un motif.

[ Surlignage conditionnel... J

S — B
Rampe de Lancement 117 Pages 6.1 pour macOS Page 26



B Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
8006 |# execicetableaucilac.pages — Modifié :

7l Tl Ao M O ] = i i e

Tableau Cellule Texte Disposition

Format des données

Tableau des activités du CILAC.

| Automatique 5]
(@) A B c D E ) ()
s I | L &L
1 ' Semaine 20
13/05 | mardi 14h30 a 16h30 Appareil photo numérique 2, utilisation, Josette

Ramnliceana q
2 réglages ‘ %

Aucun remplissage
| v Remplissage couleur
3 14/05 mercredi | 09h30 a 11h30 | Ininiation Thérése - Luc Remplissage dégradé
3 I i Remplissage dégradé avancé

4 14105 mercredi  14h30 a 16h30 Apple - le Pages qui te plait Yves Remplissage par image
Remplissage image avancé
5| 15/05 | mercredi 14h30 a 16h30 | Initiation utilisation iPad sous iOS 7 Yves —
T Y| BEO
6| 15/05 jeudi 17h00 & 19h00 ASSEMBLEE GENERALE DU CILAC 3pt @ -Q | |
=) Choisissez un style de bordure puis
cliquez sur un motif.
[ Surlignage conditionnel... ]

B Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
8006 | execicetableaucilac.pages — Modifié ‘

EEEETES R = P g - i % O @ T | S

A—

Format des données
Tableau des activités du CILAC. [ Automatigue = J
(@) A B c D E ) ()
= 1 ! &
1| ' Semaine 20
13/05 | mardi 14h30 a 16h30 Appareil photo numérique 2, utilisation, Josette v Remplissage
2 réglages P g -
L | [ Remplissage dégradé :]
3 14/05 <mercredi | 09h30 a 11h30  Ininiation Thérése - Luc -§] Elz]
4 14005 mercredi | 14h30a16h30 Apple - le Pages qui te plait Yves D Angle : Q
5| 15/05 'mercredi | 14h30 & 16h30 | Initiation utilisation iPad sous iOS 7 Yves L3
o ¥ Bordure 1
15/05 | jeudi 17h00 & 19h00 ASSEMBLEE GENERALE DU CILAC Y (B o
ol @O |1
Choisissez un style de bordure puis
cliquez sur un motif.
| surlignage conditionnel... ]

Ici remplissage en couleur d’une cellule.
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® Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
e 00 |#] execicetableaucilac.pages — Modifié e
o) [125% ] EH O Aa A+ A~ O W T 01 ul e Ol
Imprimer Zoom Tableau Prsemanon Polices HI‘SQM'I_IE Plus petit O_puleurs"p_sérer Texte Données"“llimédias Commentai hnag:r IndicF” Recherche
Tableau Texte Disposition
ercher
Recherc|

I ‘

A B
Semaine 20
13/05 | mardi
14/05 | mercredi
14/05 | mercredi
15/05 | mercredi
15/05 | jeudi

Tableau des activités du CILAC.

[ D
14h30 a 16h30 Appareil photo numérique 2, utilisation,
réglages
09h30 a 11h30 | Ininiation

14h30 &4 16h30 Apple - le Pages qui te plait

14h30 & 16h30 | Initiation utilisation iPad sous iOS 7

17h00 & 19h00 ASSEMBLEE GENERALE DU CILAC

Josette

Thérése - Luc
Yves

Yves

Format des données

| Automatique 3

¥ Remplissage

| Remplissage dégradé &

@0 -
__[§)

¥ Bordure [

ETRE i e———a

Surlignage I ]

T3]

270°

D Angle:(, ) |

. Choisir un style de bordure :

Appliquer le style & :

H O

Choisissez un s}
cliquez

( Réinitialiser |

—

Depuis I'outil bordure de I'onglet cellule vous pouvez appliquer un style a une bordure.
Depuis 'onglet texte vous pouvez choisir une police, taille, gras, italique, etc.
Vous pouvez aussi choir un espacement entre lignes, changer 'alignement, etc.

e cvun 1AUICAU  FITNTIAUUI TUILES TIU3 YIaNU  FIU3 PEUL LUUIEUIS IISEIT 1eAw = ranayer munes neweue
Tableau Cellule Texte
Placement d’objet
Tableau des activités du CILAC. | Rester sur la page Avec le texte
() A B c D E Ll
— - Ajustement du texte
1 Semaine 20 | a_ Incorporé au texte 3|
13/05  mardi 14h30 & 16h30 Appareil photo numérique 2, utilisation, Josette
2 réglages | % =
Position Espacement Alpha
L
|3 14/05 | mercredi  09h30 & 11h30T Ininiation lThérése - Luc
4 14/05 mercredi  14h30 & 16h30 Apple - le Pages qui te plait Yves ‘ ] | |- )
Arriére Avant ‘ Plan inf. Plan sup.
5 15/05 | mercredi 14h30 &4 16h30 | Initiation utilisation iPad sous i0S 7 Yves
Aligner v Répartir v
6 15/05 | jeudi 17h00 & 19h00 ASSEMBLEE GENERALE DU CILAC B B
Taille 16,47 cm|(3) | 6,82 cm|(3]
= Largeur Hauteur
N Conserver les proportions
Position = =
X V7
Faire pivoter
Angle Miroir
Verrouiller Déverrouiller
Regrouper Dissocier
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Les modeéles de Pages.

Modeles proposés par Pages.

Au lancement de Pages ou quand vous créez un nouveau document vous avez acces a
plusieurs modeles qui sont classés par grands themes.

Vierge Vierge - Paysage Prise de notes

Standard.

Reportage Dissertation Rapport scolaire Publication de recherche Rapport moderne Proposition de projet

AFNOR Lettre classique Lettre moderne Lettre professionnelle Lettre traditionnelle Lettre avec photo Lettre élégante

Urna
Semper

Lettre en gras Lettre informelle

Rapports.

Lettres.

Enveloppe classique Enveloppe moderne Enveloppe Enveloppe élégante Enveloppe en gras Enveloppe informelle
rofessionnelle_2

Enveloppes.
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Curriculum Vitae CV classique

Curriculum Vitae CV classique

Urna
Semper

CV moderne CV professionnel CV élégant CV en gras

Urna
Semper

CV moderne CV professionnel CV élégant CV en gras

Divers.

Cartes de visite classiques Cartes de visite modernes Cartes de visite Cartes de visite élégantes Cartes de visite en gras

Prospectus A louer Prospectus A vendre

Petite affiche de Grande affiche de
I'événement I'événement

Untitied
Event

Grande affiche d'imprimerie

Rampe de Lancement 117

Cartes de visites.

ET IPSUM LOREM ELIT

1234567690
Lorem Ipsum Dolor:Amet
et

Prospectus a tabulations Prospectus Immobilier Prospectus Perdu/Trouvé Petite affiche

Petite affiche de la féte Grande affiche de la féte Petite affiche scolaire Grande affiche scolaire

Prospectus et affiches.

Pages 6.1 pour macOS

CV informel

CV informel

Cartes de visite informelles

Grande affiche

Petite affiche d'imprimerie

Page 30



Carte avec photo verticale Carte avec photo Carte d'anniversaire Carte postale Immobilier Carte postale de Carte postale de
horizontale I'événement déménagement

Cartes.

Facture Dépliant élégant Dépliant - Musée

Divers.

LOREM IPSUM % e

: e ( LOREM
L] B PR [T
“ e

sl iasa

Bulletin Bulletin d’informations du Bulletin simple Bulletin serif

Bulletins.

d'Excel 2011
pour le Mac.

modéle-Rampe1 monmodelel

Mes modeles.

Dans mes modeéles vous pourrez enregistrer vos propres modeéles.
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Les styles dans Pages.

Dans Pages, vous pouvez utiliser les styles pour mettre du texte en forme avec rapid-
ité et facilité.

e Divers types de styles sont disponibles au départ; vous pourrez les modifier et en
créer de nouveaux.

e Les styles de paragraphe définissent I'aspect du texte d'un document, au niveau du
paragraphe.

o L'application d'un style de paragraphe affecte le paragraphe entier.

e Les styles de paragraphe servent généralement a contréler la mise en forme
générale de grandes parties de texte.

e Les styles de paragraphes servent aussi de base a la création des tables des
matieres.

e Les styles de paragraphe peuvent contenir toutes les regles de mise en forme des
styles de caractéres, mais contrélent également I'apparence du paragraphe, y com-
pris I'alignement du texte, les tabulations, l'interligne et les bordures.

Partager Fenétre Aide

Inspecteur > "/ Formater )
L3

Cl Afficher les vignettes de page 3P Mise en page

On peut voir les styles depuis présentation > inspecteur > styles.

Présentation Partager Fenétre Aide
Sans titre e |
) T LR [1:] Q) Q » |
urs Insérer Texte Données multimédias Partager Indices Recherche ’
1
Texte

‘

courantllj
D
Stylg Disposition Plus f
Police "

Ici le style de paragraphe est courant11].
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Présentation Partager Fenétre Aide Texte
Sans titre |

) T _ en ‘ UN©) Q. »
urs Insérer Texte Données multimédias Partager Indices Recherche { Courantll_] ‘*
Texte L
courant11j v | Styles de paragraphe - —|
H
] !
= = -
lz_k Disposition Plus ‘ ' Tlt re '
"
Police "
. =
Sous-titre :
- Lpt|(5)
. _ . En-téte | B
A droite vous pouvez voir les différents .§‘|
styles qui existent pour ce document Sous-section 2 L;|
Pages. Ss-section 3

Sous-section rouge
Corps

v couranti1j

T

Introduction E
Titre3 I

TITRE2 ‘%"
TITRE1 %p—ﬂ
LEGENDE N
En-téte, bas de page ppe/l3)

-

Note de bas de page

4

|

Etiquette Foncé —

i | Retrait=|0em|[z)7 " 0 cm |
Puce Texte
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Création du premier style.

B —

f Pages Fichier FEdition Insertion Format Disposition Présentation Partager Fenétre Aide

8 006

Sans titr

=) [125% -] g A/ = () Texte
Imprimer Zoom Tableau Présentation Polices Plus grand Plus petit Couleurs
Corps*
Titre 1. .
Styles de paragraphe
Titre 2

Titre

Maintenant je voudrais créer mon pre-

; CEm

)

mier style. : v
Y Sous-titre F
o A
J'ai tapé un exemple du type de texte En-téte ‘ pt|(+)
que je voudrais obtenir (police, taille,
couleur, cadrage, etc.). Le texte sélec- Sous-section 2 E
tionné est attribué, actuellement, a _ v
Corps. Ss-section 3 J
- i \
Je pourrais modifier corps pour qu'il Sous-section rouge | =
prenne les caractéristiques du texte v Corps =
Sélectionné en cliquant sur mise a jour LEGENDE f |
ou créer un nouveau style en cliquant sur . | -
+ (plus), situé a droite En-téte, bas de page |
Note de bas de page I
B}
|-
Etiquette Foncé (4]
,1' aa
‘ exts | Texte
Corps 1 Corps 1
R Styles de paragraphe '; ,;\ . Styles de paragraphe + *‘ Page,s a Ctileecéjn nOl_leeaul Style
- Cr:éez un stylé - ; qul S appe e OrpS ; je e
Titre r Titre | modifie en Titre1.
Sous-titre o~ Sous-titre =
En-téte E En-tét e
. e n-tete
Sous-section 2 o Sous-section 2 E_
Ss-section 3 %‘ Ss-section 3 =
Sous-section rouge L Sous-section rouge
Corps ii‘ Corps g;‘
Corps 1 = Titre1 ' L
LEGENDE yL— ) LEGENDE = |

Rampe de Lancement 117 Pages 6.1 pour macOS
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Modification d’un style.

— S ———

@ Pages Fichier Edition Insertion m Disposition Présentation Partager Fenétre Aide

® 06 Aﬂ_ Afficher les polices ®T
- T exte >
e T%u PreseE Po v Gras #8 L I Ind® m?m))
mprimer ‘oom al ntation g Tableau > ltalique % Partager ices ercl
Graphique > Souligner U Texta
Figures et lignes > Barré [
Image > Structure
Vidéo > trel v
1 Plus grand #®+
Titre du dOCUME! copicricarye  <xc P2 2+ |
Coller le style A4 E- Disposition Plus |
. 3 Espacement des caractéres >
Ceci est l'introduction. Ajouter un lien K Ligature >
Supprimer e lien Ligne de base > i
c’est le titre 2. Avancé S Majuscules > | V?ucim = )
out en majuscules — -
oy . B etites majuscul(s 0
C'est maintenant le texte courant justifié. R 7
(B Casse de titre | &)
Styles de \Ecun*v\
caractéres —

Ici j'ai sélectionné le texte titre du document, qui correspond a Titre1, et je veux lui don-

ner un style petites majuscules.

Rampe de Lancement 117 Pages 6.1 pour macOS

bhsiin Le style de Titre 1 sera:
epetites majuscules;
TITRE1* - m epolice Helvetica,
een gras;
etaille 24 points;
Style Disposition Plus } e€n rouge.
e Pour enregistrer le style modifié, cliquez sur
mettre a jour.
| Helvetica =
: Le document sera mis a jour avec la modifica-
| Gras +] | 24 pt)[] tion du style.
el v » D
Styles de | - oz |
caractéres
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Enregistrer comme modele.

m Edition Insertion Forma Aprés avoir effacé, si nécessaire une partie du

Nouveau... #N texte, je vais enregistrer le document Pages comme
¢ Ouvrir... #0 modéle.
i  Ouvrir un élément récent »
ey ~xw | Le modéle sera enregistré dans mes modéles et
Enregistrer ®s | sera affiché au lancement de Pages dans les mod-
5 Enregistrer sous... 0 3#8S eles.
7 Renommer...
1 Déplacer vers...
Revenir a >
i Exportation vers >

Convertir en Mise en page

1 Avancé >

|

I Définir le mot de passe...
Enregistrer comme modéle... )

-+ Format d’impression... 8P
Imprimer... #P

d Pages Fichier FEdition Insertion Format Disposition Présentation Partager Fenétre Aide

000 % monmodelel.pages "
= Aa A+ a- O I 7 T oy
Imprimer Zoom Tableau Présentation Polices Plus grand Plus petit Couleurs Insérer Texte Données multimédias Commentaire Partager Indices Recherche

Texte
/  Créer un modéle Pages personnalisé ?
o

CZ/ Ajoutez ce document a la liste de modéles ou enregistrez-le sur votre ordinateur.
|5, t11j

Annuler Enregistrer... | Ajouter a la liste de modéles |
X J

le l Disposition Plus

Los Averturiens du Bost du Monde
La reves Ses cude Mcooc am

Ala
découverte
d'Excel 2011
pour le Mac

modéle-Rampe1 modeéle-rampe85 monmodelel

Ici je vais enregistrer le document sous le nom de modele-rampe85.
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Création d’une table des matiéres.

Travail préparatoire avant de créer une table des matieres.

Pour insérer une table des matiéres, il faut
que les titres, sous-titres...soient au préal- Texte
able choisis dans votre document; par ex-
emple le titre « création d’une table des
matiéres » sera défini comme style « Titre Verdana 10 Y
1 » et le titre « Travail préparatoire... » sera
défini comme « titre 2 ».

Le choix des styles de titres se fera au fil de Style Disposition Plus
I'eau, c’est-a-dire quand on saisira le texte
(lequel texte de ce paragraphe s’appelle
« Verdana 10 »).

Dans le texte qui suit, « Lille, présentation générale » a le style « TITRE1 »,

0 2 L 4 4 8 0 12 4 Bv 20 Texte
TITREL x
- Styles de paragraphe + |
L z N1 Titre
ILLE, PRESENTATION GENERALE. _
Sous-titre B
Lille est une commune du nord de la France, préfecture du département En-téte N
du Nord et chef-lieu en région Nord-Pas-de-Calais. Surnommée la « Capi- = gptjlc
tale des Flandres », Lille est, avec ses 227 533 habitants au dernier re- titre2 .j
censement de 2011, la principale ville, aux cétés de Roubaix, Tourcoing et =
Villeneuve-d'Ascq, de Lille Métropole Communauté Urbaine!, intercommu- titre3 v
nalité qui regroupe 85 communes et compte environ 1,2 million d'habita- Ss-section 3 [
nts.

Sous-section rouge
Dans sa partie frangaise, I'unité urbaine de Lille est au quatriéme rang en
France par sa population, avec 1 018 809 habitants au ler janvier 2011, Corps

derriére Paris, Lyon et Marseille, et son aire urbaine est la cinquiéme de LEGENDE
France avec 1 158 306 habitants en 2010.

En-téte, bas de page

Plus largement, elle appartient & une vaste conurbation? formée avec les Note de bas de page
villes belges de Mouscron, Courtrai, Tournai et Menin® qui a donné nais- ﬁ
sance en janvier 2008 au premier Groupement européen de coopération I
territoriale, I'Eurométropole Lille Kortrijk Tournai, qui totalise Etiquette Foncé 8pt
plus de 2 100 000 habitants. Avec les villes de I'ancien M <
bassin minier du Nord-Pas-de-Ca- abm-ihre3 Potjlc
lais, elle participe aussi a un -
ensemblep mé-p tropolitain JTITRE]- petic
de plus de 3,8 mil- T
lions d'habitants, ¥ Puces etlistes = Aucun v
appelé « aire mé-
tropoli- taine de Pas de puces B
Lille ». Retrait : ocm|[C Ocm| C
Puce Texte

Son nom en
ancien frangais

(L'Isle),
comme en flamand frangais

(Rysel [ri:sal], et Rijsel* [rexsal] en néerlandais; de « ter Yssel ») pro-
viendrait de sa localisation primitive sur une ile des marécages de la vallée
de la Delle ou elle a été fondée. Lille et ses environs appartiennent a la
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Table des matiéres

Sélectionner les styles de paragraphe
affichés dans la table des matiéres :

Styles de paragraphe n°
Table des matiéres.
La table des matiéres est vide car aucun style de paragraphe défini n’est -
utilisé.
titre2
- titre3
~| Corps
En-téte, bas de page
~| Note de bas de page
Etiquette Foncé
Intervalle
Tout le document E
? ' | 4 6 8 10 ,.Z 14 ,“:' t\v 20 Texte
TITREL -
RELIEF ET GEOLOGIE
Style Disposition Plus
Topographie de la ville de Lille. Police

Lucida Grande

[ 2]

La ville de Lille est située a environ 20 métres d'altitude3 dans un élargis-
sement de la vallée de la Dedle. A cet endroit, les derniers affleurements Gras B [ s
crayeux (Sénonien et Turonien) de la réaion naturelle du Mélantois

| — ——
Topographie de la ville de Lille. titre2 "X
La ville de Lille est située a environ 20 métres d'altitude3 dans un élargis- Styles de paragraphe +
sement de la vallée de la Delle. A cet endroit, les derniers affleurements z I
crayeux (Sénonien et Turonien) de la région naturelle du Mélantois T|t|'e
plongent a I'ouest sous les Weppes, et, au nord, sous le Bargeul, deux ré-
Sous-titre 2
5 [°]
En-téte -~
Bpt o
v titre2 &

| — T |

| Relief et Géologie a le style « Titre1 » et Topographie de Lille a le style « titre2 ».

Insertion de la table des matieres.

Une table des matieres se met, en général, en début de document, apres la page de
garde; insérez, si nécessaire un saut de page avant l'insertion de la table de la table
des matieres puis allez dans le menu insertion > table des matieres > document
pour insérer une table des matiéres pour I'ensemble du document. Vous avez aussi la
possibilité d'insérer d’autres tables des matieres, comme par exemple une table des
matiéres pour une section.
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Table des matiéres.

Lille, présentation générale.
Géographie.

Situation

Relief et géologie

Topographie de la ville de Lille.
Hydrographie

Morphologie urbaine

Tissu urbain

Extensions de la place forte.
Destructions militaires

Projets d'aménagements
Histoire

Culture et patrimoine
Patrimoine civil

La cité philanthropique
Patrimoine militaire
Patrimoine environnemental
Patrimoine culturel
Gastronomie

Voies de communication et transports

Personnalités liées a la commune

Table des matiéres

les styles de

affichés dans la table des matiéres :

Styles de paragraphe n°

titre2

>

titre3

Corps

En-téte, bas de page

Note de bas de page

Etiquette Foncé

TITRE1

Intervalle

Tout le document

Pages crée la table des matieres, mais il indique ici que les styles de paragraphes
n‘ont pas été définis pour la table des matieres; rappelons que précédemment nous
avions défini les styles Titres1, titre2 et titre3 comme styles de paragraphes.

Dans le panneau de droite il faudra cochez les styles retenus pour créer la table des
matieres.

Table des matiéres.

Lille, présentation générale.
Géographie.

Relief et géologie

Morphologie urbaine

Voies de communication et transports
Projets d'aménagements

Histoire

Culture et patrimoine

Gastronomie

Personnalités liées a la commune

1
17
18
20
25
38
40

Sélectionner les styles de paragraphe
affichés dans la table des matiéres :

&

Intervalle

Tout le document H

Table des matiéres

Styles de paragraphe n°®

titre2
titre3

Corps

En-téte, bas de page

Note de bas de page

Etiguette Foncé

a

TITRE1

Nous cochons pour commencer TITREL.
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g L ‘ ° e ° = : < ¢ 2 _ Table des matiéres
les styles de
affichés dans la table des matiéres :
Styles de paragraphe n®
Table des matiéres.
Lille, présentation générale. 5 titre2
Géographie. 7 R titre3
Situation 7 -
Relief et géologie 9
Topographie de la ville de Lille. 9 Bl core
Hydrographie 9 o
Morphologie urbaine 1 e
Tissu urbain 11
Note de bas de page
Extensions de la place forte. 1 —
Destructions militaires 13
T Etiquette Foncé

Voies de communication et transports 17
Projets d'aménagements 18

: ] [}
Toponymie 19 2 TITREL 5
Histoire 20 Intervalle
Culture et patrimoine 25 Tout le document ﬁ
Patrimoine civil 25
La cité philanthropique 27
L'Hospice Comtesse 29
Patrimoine militaire 30
La Citadelle. 30
Patrimoine environnemental 31
Patrimoine culturel 32
Théatres et salles de spectacle 34
Cinéma 36
Gastronomie 38
Personnalités liées a la commune 40

Nous cochons ensuite titre2.
Et pour terminer nous cochons titre 3; la table des matieres a été créée.
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Classement des styles dans le panneau des styles.

QagnC W 9 <

jertion Format Dispesition Présentation Partager Fendtre Alde

Litle-articlelong1.pages

| =R Aa As A- o v& T N =
Tableas Présemtation Polces Plus grand Plus pett Couleurs Insérer  Texde  Dosndes mutimédias Comwnentare

- ‘. \.4\.0"". » -nn:a N Se \.n- lyn.--;‘ w--yu.lv\‘ e \:Il"‘u" WG e -}
ville. Des remparts qui la ceinturaient du Moyen Age jusqu'au début du
XXe siéclelSS subsistent :

Ia Noble Tour, qui abrite aujourd™hui le mémorial de la déportation, der-
niére trace des 65 tours médiévales qui entouraient la ville (début Xye
siécle) ;

1a porte de Gand et |a porte de Roubaix, vestiges de l'ancienne enceinte
espagnole édifiée a partir de 1621 (début XVile siécle) ;

la porte de Paris, construite en I'honneur de Louis XIV aprés la
conquéte de la ville (fin du XVlie siécle) ;

des pans de fortifications noyés dans la verdure 3 I'extrémité de l'ave-
nue du Peuple belge ;

la porte de Dunkerque, édifiée 3 1a suite du dernier agrandissement de
Ia ville fortifiée de 1858 (seconde moltié du XIXe siécle).

De nombreux édifices militaires ont par ailleurs été reconvertis. C'est le
cas notamment de I'ancien corps de garde de la gamison de la ville qui
abrite désormais le théitre du Nord, de la caserne Sauham, dont une par-
tie des btiments d'origine est aujourd’hui occupée par le CNRS, de I'anci-
en « magasin au bled des chiitellenies de Lille, Douai et Qrchigs », affecté
& I'Armée au début du XiIXe siécle et reconverti en logements d"habitation
au ¢ébut des années 2000156 ou encore de I'hdpital militaire, abandonné
par 'Armée en 1998 et racheté en 1999 par le Ministére de I'Intérieur en
vue d'y Installer les annexes de la Préfecture du Nord.

Texte
titre3* v

Styles de paragraphe

Titre

Sous-titre £\
En-téte
titre2

7 titre3
Ss-section 3
Sous-section

Corps
LEGENDE

En-site, bas do pag]
Note de bas de page

hge

Etiquette Foncé

TITREL L

T Aprés le paragraghe

2 EN

Rechorche Format  Decament

=

&

)

6pt 2

| B

Opt °

Opt °

Styles de paragraphe + Styles de paragraphe +
TITRE1 TITRE1
Titre titre2
Sous-titre v titred
En-téte Titre

tijre2 Sous-titre
7 titre3 En-téte
Ss-section 3 Ss-section 3
Sous-section rouge Sous-section rouge
Corps Corps
LEGENDE LEGENDE
En-téte, bas de page En-téte, bas de page
Note de bas de page Note de bas de page
- 7 Avant la naranranha
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Vous pouvez classer les styles selon
vos désirs, il suffit de sélectionner

et de glisser le style.

Ici le style TITRE1 est glissé vers le
haut; ce sera ensuite le tour de

titre2 et de titre3.
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